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ABSTRACT 

  

 Palm oil mill effluent (POME) is a wastewater produced by palm oil milling 

activities which generated from crude oil clarification process, sterilization process 

and cracked mixture separation process. Palm oil mill effluent (POME) is a highly 

polluting material and activated sludge system is now commonly used for the process 

of purification of the wastewater. Activated sludge system is a complex ecosystem in 

which the efficiency is quite dependent on the operating conditions of the process. Due 

to its complexity, any imbalance between the different types of microorganism may 

take place and affect the efficiency of the plant with profound economic and 

environmental consequences. To observe and regulate activated sludge system, bright 

field microscopy is acquired to monitor the sludge aggregates in palm oil mill effluent 

(POME). Furthermore, the association of image processing and analysis 

methodologies with microscopy allows a precise evaluation of the activated sludge 

status. The most common problems on activated sludge is filamentous bulking due to 

the extensive growth of the filamentous bacteria which led to poor sludge settling 

ability and poor thickening characteristics of the sludge thus increase the sludge 

volume index (SVI). Therefore, the main objectives of the research work is to develop 

image analysis algorithm by using Matlab in order to identify aggregates 

characterization in activated sludge system and to develop a correlation between image 

data obtained and sludge volume index (SVI) for POME. In this research work, two 

samples will be obtained which are fresh POME collected from the mill and POME 

undergo Fenton Reagent process. A few process will be prepared for the sample 

collected namely calculating sludge volume index, image acquisition using 

microscopy, image processing and analysis, identify image analysis parameter and plot 

the correlation between SVI with determine parameter.  By conducting this research, 

image analysis algorithm can be developed to monitor sludge aggregates in POME. 

Thus, this algorithm can be used to identify bulking problems in the POME and 

establish the true nature of the phenomenon occurring inside the activated sludge 

system which normally will affect the quality of the effluent. 
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CHAPTER 1: INTRODUCTION 
 

 

1.1 Background of Study 
 

 In Malaysia, the palm oil industry is considered as one of the major agro-

industries. Malaysia currently account for 39% of world palm oil production and 44% 

of world exports. The palm oil mill effluent (POME) is an oily wastewater produced 

by palm oil processing mills which generated from three major sources namely 

Hydrocyclone waste, sterilizer condensate and separator sludge (Borja and Banks, 

1994). Palm oil mill effluent is a highly polluting material and waste water treatment 

systems for POME are now standards in the main areas of production (Chavalparit, 

2006). Process for the purification of wastewater commonly used the activated sludge 

system (Metcalf and Eddie, 1992; Horan, 1991).  

 The activated sludge system is a complex ecosystem constituted mainly of 

bacteria and protozoa (Amaral et al., 2004). The efficiency of activated sludge system 

is quite dependent on the operating conditions namely sludge flocculation, stability, 

aggregates size, morphology, density and chemical composition (Mesquita et al., 

2013). In activated sludge systems, a suitable balance between the different types of 

bacteria is essential to ensure an effective pollution removal, good sludge settling 

abilities and low suspended solid level in the final discharge (Mesquita et al., 2009). 

To observe and regulate activated sludge system, microscopy observations are 

becoming ever more important steps.  

 There are many range of options fitted for most microscopic such as bright-

field, phase-contrast or fluorescence microscopy (Mesquita et al., 2013). Furthermore, 

the association of image processing and analysis methodologies with microscopy 

allows a precise evaluation of the activated sludge status (Li and Ganczarczyk, 1991; 

Grijspeerdt and Verstraete, 1997). Image analysis can further characterize and relate 

sludge volume index (SVI) parameters with structure of activated sludge system. In 

this study, bright-field microscopy technique is being used to identify aggregated and 

filamentous biomass morphology and content in the POME. This can be subsequently 

used to monitor bulking event in the plant. Image analysis by using Matlab 7.3 (The 
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Mathworks, Natick, USA) can be developed to further recognition aggregates bacteria 

in grayscale images (Amaral et al., 2004). 

 According to Eikelboom (2010) aggregates were categorized according to their 

size: small aggregates (Deq< 25 µm); intermediate aggregates (25 <Deq< 250 µm); 

large aggregates (Deq> 250 µm) where Deq represents the equivalent diameter. Image 

analysis dataset will further used to predict the correlation between total aggregates 

area per volume (TA/Vol) and SVI (mLg-1) (Mesquita et al., 2011). By plotting the 

data, it can identify the correlation between all the variables and thus can be used to 

elucidate several disturbance that may occur in an activated sludge system. If the 

correlation is below the threshold limits, the amount of filamentous bacteria will not 

influence the SVI value. This correlation can also provide further valuable information 

regarding the biological system in the activated sludge system. This study can also 

highlighted the benefits of combining SVI determination with sludge aggregates in 

order to form the phenomena that occurred in the biological system (Mesquita et al., 

2008). 

1.2 Problem Statement 

 

Activated sludge system is a complex ecosystem compromise of a different types of 

microorganisms. Due to its complexity, any imbalance between the different types of 

microorganism may take place and effect the efficiency of the plant with profound 

economic and environmental consequences. This will eventually cause the reduction 

of effluent quality. The acceptable range of a good SVI which most plant seem to 

produce a clear, high-quality effluent is with a SVI in the range of 100 to 200 mL/g. 

Within this range, the sludge usually forms a uniform blanket before settling as it 

settles slower and traps more particulate matter. The most common problems on 

activated sludge is filamentous bulking due to the extensive growth of the filamentous 

bacteria which led to poor sludge settling ability and poor thickening characteristics of 

the sludge thus increase the sludge volume index (SVI). In order to maintain the SVI 

values, the operator would have to regulate the waste sludge rate to effectively creating 

a less dense particle that settles slightly slower or creating a denser particle that has 

rapid settling ability which will affect the effluent quality. Furthermore, image analysis 

algorithm of sludge aggregates for monitoring bulking problem in activated sludge that 

relates to SVI value are not well developed.  
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1.2 Objectives 

 

The main objective of this study is in order to: 

1. To develop image analysis algorithm in order to extract size of aggregates in 

activated sludge system. 

2. To compare the similarity of results between the existing ImageJ software with 

self-develop coding in Matlab. 

3. To determine the SVI of POME Influent and Effluent to estimate the sludge 

settling ability 

 

1.3 Scope of Studies 

 

The scope of are as following: 

1) Monitoring sludge aggregates using Light Microscopy 

2) Development of Image processing algorithm for aggregates characterization 

using Matlab.  

3) Proposed method will be applied for monitoring sludge aggregates of Palm Oil 

Mill Effluent. 
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CHAPTER 2: LITERATURE REVIEW 
 

 

2.1 Palm Oil Mill Effluent (POME) 

 

The palm oil mill effluent (POME) is an oily wastewater produced by palm oil 

processing mills which generated from three major sources namely Hydrocyclone 

waste, sterilizer condensate and separator sludge (Borja and Banks, 1994). POME is a 

highly polluting material and waste water treatment systems for POME are now 

standards in the main areas of production (Chavalparit, 2006). According to Aljuboori 

(2013) 5-7.3m3 of water is required to produce 1 tonne of crude palm oil (CPO) in 

which more than 50% of the water will end up as POME. Without proper wastewater 

treatment plant implemented in palm oil mills this huge amount of POME being 

produced will easily pollute the water sources nearby (Lam et al., 2011). 

2.2 Activated Sludge System 

 

Process for the purification of wastewater commonly used the activated sludge system 

(Metcalf and Eddie, 1992; Horan, 1991). The activated sludge system is a complex 

ecosystem constituted mainly of bacteria and protozoa (Amaral et al., 2004). The 

efficiency of activated sludge system is quite dependent on the operating conditions 

namely sludge flocculation, stability, aggregates size, morphology, density and 

chemical composition (Mesquita et al., 2013). In activated sludge systems, a suitable 

balance between the different types of bacteria is essential to ensure an effective 

pollution removal, good sludge settling abilities and low suspended solid level in the 

final discharge (Mesquita et al., 2009). One of the main problems in activated sludge 

system is the sludge settling ability and is generally measured by using the sludge 

volume index (SVI) (Mesquita et al., 2013). It is also known that formation of pinpoint 

flocs (PP), filamentous bulking, and viscous or zoogleal bulking (ZB) are common 

malfunctions that affect the activated sludge system settling ability (Mesquita et al., 

2011). Pinpoint flocs phenomenon is related to the formation of small and 

mechanically fragile spherical flocs, presenting low settling properties. Zoogleal or 

viscous bulking occurs by an extensive amount of extracellular material 

(exopolysaccharides) thus increasing the SVI and lowering the sludge settling ability. 
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According to Mesquita et al., (2011) in activated sludge system the most common 

sludge bulking problem is the filamentous bulking. Filamentous bulking normally 

occurred when different types of filamentous microorganisms overgrow consequently 

leading to poor sludge settling ability and poor thickening characteristics. (Mesquita 

et al., 2011). 

2.3 Activated sludge monitoring through microscopic examination 

 

Microscopy observations played a vital role method to monitor and control activated 

sludge systems, these method are becoming widespread for the characterization of 

activated sludge microbial aggregates. Microscopes allow the visualization of 

activated sludge and is quite effective in identifying the nature of the aggregated 

biomass and the type and abundance of filamentous microorganisms (Jenkins et al., 

2003). At most, microscopes are now fitted with a range of technique such as bright-

field, phase contrast or fluorescence microscopy.  

2.3.1 Bright-field microscopy 

 

Bright field microscopy can be used to assess the morphology of the activated 

sludge. It may also provide useful data on the sludge state, especially in 

conventional activated sludge system where flocs-forming bacteria dominate, 

increasing the aggregates size and compactness. Bright field microscopy 

proved to be more accurate in determining aggregate’s borders and assessment 

of short protruding filaments. The down side of bright field microscopy is lack 

of contrast thus this will hinders the visualization of the transparent nature of 

majority microbial cells, including filamentous bacteria (Mesquita et al., 2013). 

2.3.2 Phase-contrast microscopy 

 

Phase-contrast microscopy is helpful in identifying specific characteristics in 

filamentous bacteria identification that are hardly visualized in bright-field 

such as the presence of branching or sheath. It can also use to visualize 

activated sludge internal structures without staining and contrast filamentous 

bacteria. Phase contrast microscopy was also identified to favor the valuation 

of long protruding filaments thus stimulating filamentous bulking conditions 

identification (Mesquita et al., 2013) 
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2.3.3 Fluorescence microscopy 

 

Fluorescence probes is an attractive method to solve the problems for analyzing 

microbial populations. In activated sludge system, the combination of 

fluorescence microscopy and fluorescent in situ hybridization probes is known 

as a powerful method for in situ identification of microorganisms. However, in 

fluorescence microscopy, the quantification may be complex and subjective 

using labor-intensive counting and non-uniform fluorescence intensity values 

can cause glitches to automatic quantification procedures (Mesquita et al., 

2013) 

2.4 Image Processing and Analysis 

 

Image analysis has become a vital tools with a large field of application. This is due to 

is capability to remove human physical analysis which can avoid tedious and highly 

time consuming task and the likelihood to extract quantitative data (Amaral et al., 

2004). Image analysis by using Matlab 7.3 (The Mathworks, Natick, USA) can be 

developed to further recognition both aggregates and filamentous bacteria in grayscale 

images (Amaral et al., 2004). Nowadays, image analysis procedures is considered to 

be a feasible tools to characterize quantitatively aggregates and filamentous bacteria 

and subsequently used to prevent bulking events in the plants in the future (Mesquita 

et al., 2009). Image analysis may offer powerful information by combining the settling 

properties and the parameters obtained in which can enabling immediate interventions 

on the biological system. A study developed by Sezgin (1982) established that the 

sludge volume index (SVI) is directly influenced by flocs size and filamentous bacteria 

contents.  A basic image processing procedure can be done by the example from 

Mesquita et al., (2009) which start with image acquisition, background correction, 

image pre-processing and segmentation. The segmentation is divided into aggregates 

segmentation and filaments segmentations. According to Eikelboom (2010) 

aggregates were categorized according to their size: small aggregates (Deq< 25 µm); 

intermediate aggregates (25 <Deq< 250 µm); large aggregates (Deq> 250 µm) where 

Deq represents the equivalent diameter.  Image analysis dataset will further used to 

predict the correlation between total filaments length per volume (TL/Vol) and SVI 

(mLg-1), total aggregates area per volume (TA/Vol) and SVI (mLg-1) and total 

filaments length per total aggregates ratio (TA/TL) and SVI (mLg-1) (Mesquita et al., 
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2011). By plotting the data, it can identify the correlation between all the variables and 

thus can be used to elucidate several disturbance that may occur in an activated sludge 

system. If the correlation is below the threshold limits, the amount of filamentous 

bacteria will not influence the SVI value. This correlation can provide valuable 

information regarding the biological system in the activated sludge system (Mesquita 

et al., 2008). 
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CHAPTER 3: METHODOLOGY 
 

3.1 Materials  

 

3.1.1 Biomass Sampling 

 

There will be two sampling to be collect: 

 

1. Influent: Fresh POME will be collected from FELCRA Nasaruddin, a 

palm oil mill in Bota, Perak. 

2. Effluent: Sample will be taken after the sample undergo Fenton 

Reagent Process. Fenton Reagent Process is normally used to oxidize 

contaminants or wastewater by using a mixture of hydrogen peroxide 

and ferrous iron. It is will normally produce a very reactive hydroxyl 

radical based on the catalyzed decomposition hydrogen peroxide by 

iron (II).  

3.2 Method 

 

3.2.1 Measuring Sludge Volume Index 

 

The total suspend solids (TTS) for both of the sample was measured by weight 

(grams) and further used to analyze the sludge volume index (SVI) in a 1L 

cylindrical column for 30 min. The sludge volume index was determined by 

using equation: 

 

𝑆𝑉𝐼 =  
ℎ30

ℎ0 . 𝑇𝑆𝑆
 

 

Where h0 and h30 are the height in the time 0 and 30 min, respectively. 
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3.2.2 Bright field image acquisition 

 

1. A large diameter of recalibrated micropipette with sectioned tip at the 

end will be used to deposit samples on microscope slides. A large 

diameter of micropipette will be used to allowing the passage of larger 

aggregated to flow. 

2. Each slide a volume of 50µL of sample will covered with a 20mm x 

20mm cover slip. A total of three slides per sample will be taken. 

3. The slides were then captured by using light microscopy. The light 

microscopy used will be MEIJI Microscopy MX 4300L which is 

available at Environment Lab Block 5, Chemical Engineering 

Department 

4. Image will be captured in the upper, middle and bottom of the slide in 

order to enhance the representativeness of the microbial community in 

the samples. 

5. A new sample from the same batch will be repeated 3 times to ensure 

the integrity of the data. 

3.2.3 Measuring Total Suspended Solids (TSS) 

  

1. Measure the weight of the filter paper. Each filter paper is measured 3 

times to ensure the integrity of the data. 

2. Fold the filter paper exactly in half, the folded in quarters. 

3. The filter paper cone is then fitted to the glass funnel. 

4. Using a wash bottle filled with distilled water, wet the filter paper and 

carefully press it so that it makes maximum contact with the funnel. 

5. The effluent is then slowly and carefully poured into the funnel taking 

care not to fill the funnel above the edge of filter paper. 

6. Once the effluent have been filtered. Remove the filter and placed the 

filter on metal plate and place it in an oven for at least 1h at 103°C to 

105°C. 

7. Measure the weight of the filter paper. Each filter paper is measured 3 

times to ensure the integrity of the data. 

8. Repeat steps for influent. 
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3.2.4 Image Processing 
  

The image processing and analysis algorithm to identify size of sludge 

aggregates will be develop in Matlab 7.3 (The Mathworks, Inc., Natick) 

language. The image processing procedures are: 

 

Figure 1 Procedures of the image processing 

 

3.2.5 Image Analysis Parameters 

 

There will be 1 parameter to be determine directly from the image analysis 

algorithm. Total aggregates area per volume TA/Vol (mm2µL-1). The volume 

for the parameter will be fixed according to the volume (µL) taken during the 

image acquisition. 

 

 

 

 

 

Image acquisition from 
bright field microscopy

Background image 
correction

Image pre-treatment

Segmentation of 
Aggregates and Filaments

Debris elimination in the 
image
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3.3 Process Flow of the study 

 

 

 

Figure 2 Process Flow of the Study 

 

 

 

 

 

 

Biomass Sampling

Calculate operating 
parameters (SVI)

Image acquisition using Light 
Microscopy

Image processing using 
Matlab 7.3

Identify image analysis 
parameter

Plot the correlation between 
the  operating parameters  
and determine parameter
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3.4 Project Key Milestones 

 

Highly achievable, satisfactory and extremely relevant project milestones are 

important to keep the project in the track. The milestones for this study in the first few 

weeks are explained as follow:  

 

a) Progress Report Preparation (Week 1-Week 7)  

Preparation of progress report includes, summary of project progress and 

future work is added to the report. The student will modify the previous 

interim proposal according to the comments and feedback from the proposal 

defence with better understanding and knowledge of study.  

 

b) Experimental Activities (Week 1- Week7)  

Student is obligatory to meet the supervisor to get the main ideas on the study. 

Project started with reading the journals and books that relevant to the study 

before proceeding to the extended proposal preparation.  

 

c) Progress Report Submission (Week 8) 

Student is required to send in the Progress report to the supervisor during week 

8. Amendment will be made to the report if there are any changes.  

 

d) Pre-Sedex (Week 11) 

Students is required to develop a poster for a short presentation to report on the 

progress of their work to a panel of internal examiners 

 

e) Dissertation Report Submission (Week 13) 

To submit a complete draft of dissertation to Supervisor. Supervisor will 

examine that report and make comments any changes needed to be made. 

 

f) Technical Paper Submission (Week13) 

To submit a complete technical paper which consist of 5 pages two column 

with reference to the FYP guidelines provided 

 
 



  

13 
 

3.5 Project Timeline 
 

Table 1 Gantt chart for Final Year Project II 

 

 

No. Detail 
Week 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

1 FYPII Activities: Experimental Work                             
 

2 Progress Report Submission                             
 

3 FYPII Activities: Simulation Work                             
 

4 Pre-EDX                             
 

5 Submission of Draft                             
 

6 Project work continue: Analysis and reporting                             
 

7 Submission of Softbound                             
 

8 Submission of Technical Paper                             
 

9 Oral Presentation                             
 

10 Submission of Hardbound                             
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CHAPTER 4: RESULTS AND DISCUSSION 
 

4.1 Sludge Volume Index 

 

Influent obtained = 1 liter 

Effluent obtained = 84 milliliter 

 

After 30 minutes of settling 

 

  

  Figure 3 Influent settling after 30 min         Figure 4 Effluent settling after 30 min 

 

Influent sludge = 110 mL 

Effluent sludge = 3 mL 

 

4.1.1 Formula to measure SVI 

 

SVI =
(settled volume of sludge, mL/L)(103 mg/g)

(suspended solids, mg/L)
=

mL

g
 

 

Calculations for SVI is done at the end of experiment after total suspended solids are 

calculated.  
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4.2 Light Microscopy image 

 

Image are taken for influent and effluent using Meiji Microscopy MX4300L.  

 

Sample Image of Influent under light microscopy 

 

Figure 5 Influent under Light Microscopy x10 Magnification 

 

Sample image of Effluent under light Microscopy 

 

Figure 6 Effluent under Light Microscopy x10 Magnification 
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4.3 Total Suspended Solids 

 

Influent 100mL 

Table 2 Total Suspended Solids for Influent 

 Trial 1 Trial 2 Trial 3 Average 

Filter Paper 1.5689 g 1.5692 g 1.5695 g 1.5692 g 

Filter Paper + Sludge 3.0202 g 3.0247 g 3.0277 g 3.0242 g 

Sludge Weight 1.4513 g 1.4555 g 1.4582 g 1.4549 g 

 

Effluent 84mL 

Table 3 Total Suspended Solids for Effluent 

 Trial 1 Trial 2 Trial 3 Average 

Filter Paper 1.5554 g 1.5552 g 1.5540 g 1.5549 g 

Filter Paper + Sludge 1.5767 g 1.5863 g 1.5902 g 1.5844 g 

Sludge Weight 0.0213 g 0.0311 g 0.0362 g 0.0295 g 

                  

                                  

Figure 7 Influent filter paper after filtration          Figure 8 Effluent filter paper after filtration 

4.3.1 Formula to measure TSS 

𝑚𝑔 𝑡𝑜𝑡𝑎𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑑𝑒𝑑 𝑠𝑜𝑙𝑖𝑑/𝐿 =
(𝐴 − 𝐵) 𝑋 1000

𝑠𝑎𝑚𝑝𝑙𝑒 𝑣𝑜𝑙𝑢𝑚𝑒, 𝑚𝐿
 

Where: 

A = weight of filter + dried residue, mg, and 

B = weight of filter, mg 
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Calculation for TSS 

Influent 

Weight of filter + dried residue = 3024.2 mg 

Weight of filter = 1569.2 mg  

Sample volume = 100 mL 

 

𝑚𝑔 𝑡𝑜𝑡𝑎𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑑𝑒𝑑 𝑠𝑜𝑙𝑖𝑑/𝐿 =
(3024.2 − 1569.2) 𝑋 1000

100
 

= 14550𝑚𝑔 𝑡𝑜𝑡𝑎𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑑𝑒𝑑 𝑠𝑜𝑙𝑖𝑑/𝐿 

 

Effluent 

Weight of filter + dried residue = 1584.4 mg 

Weight of filter = 1554.9 mg  

Sample volume = 84 mL 

𝑚𝑔 𝑡𝑜𝑡𝑎𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑑𝑒𝑑 𝑠𝑜𝑙𝑖𝑑/𝐿 =
(1584.4 − 1554.9) 𝑋 1000

84
 

= 351.19 𝑚𝑔 𝑡𝑜𝑡𝑎𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑑𝑒𝑑 𝑠𝑜𝑙𝑖𝑑/𝐿 

 

Calculation for SVI 

 

Influent 

Settled volume of sludge = 110 mL/L 

Suspended Solids = 14550 mg/L  

SVI =
(settled volume of sludge, mL/L)(103 mg/g)

(suspended solids, mg/L)
=

mL

g
 

SVI =
(110

mL

L
) (103 mg

g
)

(14550
𝑚𝑔

𝐿
)

 

SVI =  7.56 mL/g   
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Effluent 

Settled volume of sludge = 35.71 mL/L 

Suspended Solids = 351.19 mg/L  

SVI =
(settled volume of sludge, mL/L)(103 mg/g)

(suspended solids, mg/L)
=

mL

g
 

SVI =
(35.71

mL

L
) (103 mg

g
)

(351.19
𝑚𝑔

𝐿
)

 

SVI =  101.69 mL/g   

 

Sludge Volume Index  

Table 4 Sludge Volume Index Result 

Sample Sludge Volume Index 

Influent 7.56 mL/g 

Effluent 101.69 mL/g 

 

Total Suspended Solids 

Table 5 Total Suspended Solids Result 

Sample Total Suspended Solids 

Influent 14550 mg/L 

Effluent 351.19 mg/L 

 

 

Discussion 

 

From the calculation of total suspended solid above, the value of effluent which are 

351.19 mg of total suspended solids/L is relatively lower than the value of influent 

which are 14549 mg of total suspended solids/L. These result shows that the effluent 

which undergo Fenton Process managed to reduce the total suspended solids in the 

POME. These results also prove that the Fenton Process is effective in pollution 

removal, display good sludge settling abilities and low suspended solids in the POME. 

Once the total suspended solids is calculated, sludge volume index is then calculated. 

The SVI is calculated using the formula with reference to the standard method for the 

examination of water and wastewater. From the SVI calculation above, the SVI value 
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for Influent is 7.56 mg/L and Effluent is 101.69 mg/L. A desired value for SVI is below 

100, it is considered a good settling sludge. While SVI above 150 are usually 

associated with filamentous growth (Parker et.al, 2001). From the result above, 

effluents value shows a desired value while Influent shows an error in the results. The 

errors in the Influent is due to high amount of suspended solids thus increase the 

filtration times. Prolonged filtration times resulting from filter clogging may produce 

high results owing to increased colloidal materials captured on the clogged filter and 

produce an error in the calculations. 
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4.4 Aggregates Size Analysis Using ImageJ 

 

All the influent and effluent image captured by the microscope were then analyze by 

using ImageJ software. The analysis consist of 7 parameters. Below are the list of 

parameters involved in the analysis. 

i. Particle Count 

ii. Total Area of aggregates in the image 

iii. Average Size of aggregates in the image 

iv. Percentage area of aggregates in the image 

v. Perimeter of the total aggregates in the image 

vi. Fit ellipse of aggregates 

vii. Feret’s Diameter of the aggregates 

Influent 

A total of 77 images of influent taken for each sample. The images was captured by 

using Meiji MX4300L Microscope. The images were taken with 2 type magnification 

which are x4 magnification and x10 magnification. The image were then analyze using 

ImageJ software and further analyze using Microsoft Excel. (APPENDIX 1)  

 

Figure 9 Average Size and Total Area of Influent 
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Effluent 

A total of 72 images of effluent taken for each sample. The images was captured by 

using Meiji MX4300L Microscope. The images were taken with 2 type magnification 

which are x4 magnification and x10 magnification. The image were then analyze using 

ImageJ software and further analyze using Microsoft Excel. (APPENDIX 2) 

 

Figure 10 Average Size and Total Area of Effluent 

 

Discussion 

From Figure 9 Average size and total area of Influent, it shows that the size of particles 

and total area of particles per images is not consistent. This is due to many irregular 

shape and amount of aggregates per image. In contrary with figure 10, the effluent 

sample which undergo Fenton Process, the average total area of aggregates can be seen 

is almost the same for all the images which prove that Fenton Process managed to 

reduce the total area of aggregates in the sample. 
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Influent 

From the total of 77 images captured in influent, ImageJ identified a total of 7504 

individual particles. Figure below is the histogram of the total number of particles per 

image vs the frequency of image. 

 

 

Figure 11 Histogram Analysis for Influent 

 

From Figure 11 above, the highest number of particles recorded per image is 80 

particles with a frequency of 20 images. Followed by 120 particles per image with 13 

images. This proves that Influent have less number of particles compare to Effluent. 

Even though Influent have less particles per image, but the aggregates size of Influent 

is relatively bigger compare to Effluent.  
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 Effluent 

From the total of 72 images captured in influent, ImageJ identified a total of 22480 

individual particles. Figure below is the histogram of the total number of particles per 

image vs the frequency of image. 

 

 

Figure 12 Histogram Analysis for Effluent 

 

Based on Figure 12 above, the highest frequency of images contains number of 

particles are 260 and above. This shows that effluent contains more number of particles 

per image compare to influent.  With refer to Figure 14 below, the high number of 

particles per image is due to small size particles which dominated the image. This is 

because the effluent undergo Fenton Process have purify the POME content by filter 

out the large size of aggregates.  

0

5

10

15

20

25

30

35

40

45

Fr
e

q
u

e
n

cy

Number of Particles

Histogram Effluent

Frequency



  

24 
 

4.5 Aggregates Size distribution Analysis Using ImageJ 

Influent 

 

Figure 13 Influent Individual Particle Analysis 

Effluent 

 

Figure 14 Effluent Individual Particle Analysis 
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Discussion 

Figure 13 and Figure 14 is the aggregates size distribution analysis using ImageJ for 

Influent and effluent respectively. From Figure 13, it shows that around 70% of 

aggregates have the particle size 10 um2 and below. Meanwhile, it also display large 

size of aggregates which is around 250-360 um2 and 6000 um2. This proves that the 

Influent contains aggregates size which differ in size and volume. In contrary with 

Figure 14, the effluent contains around 79% of number of particles which have size 10 

um2 below. In also display no large aggregates in the sample. This proves that the 

Influent which undergo Fenton Process managed to filter out the large aggregates 

which are contains in the sample. From the Figure 14 also, it can be concluded that the 

Effluent contains more number of particles in small sizes compare to Influent which 

display in Figure 13.   
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4.6 Aggregates Size Distribution Analysis using Matlab 

 

Influent 

A Matlab analysis is conducted using the same image sample from ImageJ. From the 

Figure below, it shows that aggregates particles with the equivalent diameter of 10 um 

and below have the most frequency which is 80% out of the 3913 particles identified. 

The difference in amount of particles identified in Matlab and ImageJ is due to the 

different threshold value set between the two software. Based on the figure below also 

it can be concluded that Influent contains aggregates which are large in size which are 

equivalent to 100 um and above. This proves that the influent contains waste that are 

large in size that may affect the SVI values.  

   

 

Figure 15 Diameter Distribution for Influent using Matlab 
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Effluent 

A Matlab analysis is conducted using the same image sample from ImageJ. From the 

Figure below, it shows that aggregates particles with the equivalent diameter of 10 um 

and below have the most frequency which is 98% out of the 21085 particles identified. 

The difference in amount of particles identified in Matlab and ImageJ is due to the 

different threshold value set between the two software. Based on the figure below also 

it can be concluded that effluent contains no aggregates which are larger than 

equivalent diameter of 80 um. This proves that Fenton Process managed to reduce the 

aggregates size in the effluent. 

 

 

Figure 16 Diameter Distribution for Effluent using Matlab 
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4.7 Comparison Images of ImageJ and Matlab 

 

 

Figure 17 Original Image from Light Microscopy 

 

Figure 18 Threshold using Matlab 
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Figure 19 Identifying Particles using Matlab 

 

Figure 20 Threshold using ImageJ 
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Figure 21 Identifying Particles using ImageJ 

 

Discussion 

 

From the comparison of Tresholding in Figure 17 and Figure 19, is shows that the two 

software Matlab and ImageJ are using a vice versa color identification. In Matlab, 

particles are label as white color while in ImageJ particles are label as black color. 

Even though there may different in the color scheme of the two software, the results 

display remain the same between the two software. Refer to Figure 18 and Figure 20, 

the particles are label by using ellipse. This process is by labelling particles into ellipse 

to make it easier to identify the diameter or length of individual particles as each 

particles have different sizes and shapes. For the Tresholding values, both software 

Matlab and ImageJ is set with the value 85. This is to ensure the consistency of data 

between those two. Finally, it can be concluded that, the both software gave the same 

result, thus the Image Analysis Algorithm using Matlab is correct.   
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4.8 Scale identification using ImageJ Software 

 

Scale identification is important to identify the area of an aggregates in the image. 

Different magnification of microscopy will produce different length of pixels in the 

image. Below are the steps required to identify the length of pixel per micrometer. 

Step 1: Open image file location 

File > Open (Select the image) 

 

Figure 22 Example of Selected Image (magnification x10) 

Step 2: Convert image type to grayscale 

If the current image type is under the format of RGB Colors, the image need to convert 

to 8 – bit grayscale. This will converts the image to 256 shades (8-bit) of gray. 

Image > Type > 8-bit 

 

Figure 23  After converting to 8-bit grayscale 
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Step 3: Tresholding (Binary Contrast Enhancement) 

There are two methods to create a threshold binary image 

1. Automatic: Process > Binary > Make Binary 

2. Manually: Image > Adjust > Threshold 

 

Figure 24  After threshold process 

 

Step 4: Draw a line between two points 

Click the line selection tools at tool bar. Then manually draw a straight line between 

the two points in the image 

Step 5: Set Scale for the image 

This functions is to define the spatial scale of the active image so measurement results 

can be presented in calibrated units, such as mm or µm. The distance in pixel will be 

automatically filled in based on the length of the line selection in Step 4 

Analyze > Set Scale 

 

Figure 25 Set Scale table in ImageJ 
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Step 6: Insert Scale Bar into the image 

This function is to integrate a scale bar into the image. The scale bar is measured 

according to the scale defined in Step 5 

Analyze > Tools > Scale Bar 

 

Figure 26 Integrated Scale Bar in the image 

 

Below are the table for scale identification for different magnification images. Based 

on data provided from ImageJ, it showed that image with magnification of 4x will 

produce a length of 1.467 µm for every 1 pixels of the image. Image with 

magnification of 10x will produce a length of 0.586 µm for every 1 pixels of the image. 

To further ascertain the correlation between the two magnification data, manual 

calculation is being made.  
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Table 6 Scale Identification Data 

 

Sample Calculation  

 

Based on the data with known distance 0.1mm: 

Magnification 4x  = 68.0294 pixels 

Magnification 10x  = 170.6667 pixels 

 

For Magnification 4x calculation: 

𝑀𝑎𝑔𝑛𝑖𝑓𝑖𝑐𝑎𝑡𝑖𝑜𝑛 4𝑥 = 68.0294 𝑝𝑖𝑥𝑒𝑙𝑠 

𝑀𝑎𝑔𝑖𝑛𝑖𝑓𝑖𝑐𝑎𝑡𝑖𝑜𝑛 1𝑥 = 68.0294 𝑝𝑖𝑥𝑒𝑙𝑠 ÷ 4  

𝑀𝑎𝑔𝑛𝑖𝑓𝑖𝑐𝑎𝑡𝑖𝑜𝑛 1𝑥 = 17.0035 pixels 

 

For Magnification 10x calculation: 

𝑀𝑎𝑔𝑛𝑖𝑓𝑖𝑐𝑎𝑡𝑖𝑜𝑛 10𝑥 = 170.667 𝑝𝑖𝑥𝑒𝑙𝑠 

𝑀𝑎𝑔𝑖𝑛𝑖𝑓𝑖𝑐𝑎𝑡𝑖𝑜𝑛 1𝑥 = 170.667𝑝𝑖𝑥𝑒𝑙𝑠 ÷ 10  

𝑀𝑎𝑔𝑛𝑖𝑓𝑖𝑐𝑎𝑡𝑖𝑜𝑛 1𝑥 = 17.0667 pixels 

 

For the calculation above, the two data correlate with each other as they both give the 

same answer for Magnification 1x = 17 pixels. This also can proved that the calculation 

from ImageJ software is correct for Scale identification. With the base line of 

Magnification 1x is identified, the base line can be integrated to be used to any 

magnification in the microscope. 

Magnification Known 
Distance 

(mm) 

Distance 
in Pixel 

Distance 
in µm 

Scale 
pixels/mm 

Scale  
pixels/ µm 

Distance µm 
/ pixels 

4x 0.01 6.8354 9.96 683.54 0.6835 1.463 

  0.05 34.0147 49.99 680.29 0.6803 1.47 

  0.1 68.0294 99.96 680.29 0.6803 1.47 

Average    681.3733333 0.681366667 1.467666667 

10x 0.01 17.3754 9.78 1737.54 1.7375 0.576 

  0.05 84.0106 49.99 1680.212 1.6802 0.595 

  0.1 170.6667 100.2 1706.667 1.7067 0.586 

Average    1708.139667 1.708133333 0.585666667 
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4.9 Aggregates area identification and measurement using ImageJ 

 

Step 1: Open image file location 

File > Open (Select the image) 

 

 

Figure 27 Sample image 

Step 2: Convert image type to grayscale 

If the current image type is under the format of RGB Colors, the image need to convert 

to 8 – bit grayscale. This will converts the image to 256 shades (8-bit) of gray. In this 

scale 0 = pure black and 255 = pure white 

Image > Type > 8-bit 

 

 

Figure 28 Grayscale Image 
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Step 3: Tresholding (Binary Contrast Enhancement) 

Tresholding is also known as “Segmentation”. Tresholding works by separating the 

pixels which fall within a desired range of intensity values set by the users or 

systems. The separating of the pixels will produce a black and white image. 

There are two methods to create a threshold binary image 

1. Automatic: Process > Binary > Make Binary 

2. Manually: Image > Adjust > Threshold 

Both of this method will produce almost similar result 

 

 

Figure 29 Automatic Tresholding image 

 

 

Figure 30 Manual Tresholding Windows 
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There are more process available in ImageJ commands to create or process binary 

(black and white) images. Some of the sample and process are listed below. 

Outline 

This command generates a one pixel wide outline of foreground in a binary image. 

The line is drawn inside the object 

Process > Binary > Outline 

 

Figure 31 Sample outline image 

Skeletonize 

This command repeatably remove the pixels from the edges of the objects in a binary 

image until they are reduced to single pixel wide shape 

Process > Binary > Skeletonize 

 

Figure 32 Sample Skeletonize image 
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Distance Map 

This command generates a Euclidian distance map (EDM) from a binary image. Each 

foreground pixel in the binary image is replaced with a gray value equal to that pixel’s 

distance from the nearest background pixel (for background pixels the EDM is 0). The 

Ultimate Points, Watershed and Voronoi commands are all based on the EDM 

algorithm 

Process > Binary > Distance Map 

 

Figure 33 Sample Distance Map image 

 

Functions of ultimate points, watershed and voronoi: 

 

i. Ultimate Points 

 

Generates the ultimate eroded points (UEPs) of the Euclidian distance map 

(EDM) from a binary image. Ultimate Eroded Points are maxima of the EDM. 

In the output, the points are assigned the EDM value, which is equal to the 

radius of the largest circle that fits into the binary particle, with the UEP as the 

center. 
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ii. Watershed 

 

Watershed segmentation is a way of automatically separating or cutting apart 

particles that touch. It first calculates the Euclidian distance map (EDM) and 

finds the ultimate eroded points (UEPs). It then dilates each of the UEPs (the 

peaks or local maxima of the EDM) as far as possible — either until the edge 

of the particle is reached, or the edge touches a region of another (growing) 

UEP. Watershed segmentation works best for smooth convex objects that don’t 

overlap too much. 

 

iii. Voronoi 

 

Splits the image by lines of points having equal distance to the borders of the 

two nearest particles. Thus, the Voronoi cell of each particle includes all points 

that are nearer to this particle than any other particle. When particles are single 

points, this process is a Voronoi tessellation (also known as Dirichlet 

tessellation) 

Step 4: Set Scale into the image 

Refer to 4.8 Scale identification using ImageJ, insert the relevant value into the table 

provided with refer to the magnification of the image. 

Analyze > Set Scale 

 

Figure 34 Set scale into the image windows 
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Step 5: Area measurement 

1. This command will measure all the relevant data selected from the windows 

below. 

Analyze > Set Measurement 

 

Figure 35 Set measurement windows 

 

2. This command will produce the result based on the selected data in the set 

measurement windows. 

Analyze > Measure 

Table 7 Measurement results 

Area Perim. Major Minor Angle Feret %Area FeretAngle MinFeret 

34139.32 3584 233.515 186.145 6.401 1280 12.644 143.13 768 

 

From the results above, the total area of aggregates in the image is 34319 µm2. 

While the ferret diameter is 1280 µm.  
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Step 6: Analyze Particle 

This command will counts and measures objects in the image. It works by scanning 

the image or selection until it finds the edge of an object 

Analyze > Analyze Particles 

 

Figure 36 Image containing numbered outline of the measured particles 

Based on figure 17, the command will automatically outline the particles and 

numbered the particle individually 

Table 8 Particle Analysis Result 

 Area Perim. Major Minor Angle Feret %Area FeretAngle MinFeret 

1 2545.051 2098.627 63.608 50.944 170.108 750 100 143.13 450 

2 96.474 37.809 13.132 9.354 50.373 14.554 100 49.899 10.358 

3 803.032 141.198 42.982 23.788 22.08 44.47 100 18.435 29.726 

4 30316.07 976.187 224.625 171.84 7.348 250.179 100 32.276 200.839 

5 221.443 73.901 22.615 12.467 157.444 26.832 100 148.392 15.125 

6 123.596 52.038 15.846 9.931 82.039 17.243 100 99.782 10.978 

7 28.839 24.089 7.409 4.956 97.931 8.531 100 105.945 6.166 

 

Based on table 4, the command will produce a summary of result which contains all 

the data selected from the set measurement windows in step 5. The total area for all 

particles is 34134.51 µm2. There is a difference of area 4.81 µm2 between table 4 and 

table 3. The difference is due to limits set in the software which is to only identify 

particles with area 5 µm2 and above inside the image. Based on the limits set, it can be 

concluded that both measurement produce the same results. 
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CHAPTER 5: CONCLUSION AND RECOMMENDATION 
 

Conclusion 

 

By conducting this study, image analysis algorithm can be developed to monitor 

sludge aggregates in Palm Oil Mill Effluent (POME). Thus, this algorithm can be used 

to identify bulking problems in the POME and establish the true nature of the 

phenomenon occurring inside the activated sludge system which normally will affect 

the quality of the effluent. From the experimental data of Total Suspended Solids, it 

show that influent have a higher amount of suspended solids in the POME. The SVI 

calculated for influents display an error as due to the prolonged filtration times 

resulting from filter clogging may produce high results owing to increased colloidal 

materials captured on the clogged filter and produce an error in the calculations. The 

effluent result for SVI shows an ideal value for a typical good SVI. From the image 

comparison data between Matlab and ImageJ, it can be proven that the coding for 

Matlab is correct and can be used to identify the aggregates size in the POME. This 

also proves that the POME undergo Fenton Process have less large particles in the 

solution and contain better SVI values compare to Influent which have many large 

particles in the solution. 

 

Recommendation  

To provide a comprehensive procedure to measuring Total Suspended Solids and 

Sludge Volume Index. To prepare different type of POME which have undergo 

different purification process. To obtain different POME sample from different Palm 

Oil Mill. To identify the effect of filaments in the POME. To use different method of 

Image Acquisition and Image Analysis.  
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APPENDIX 

 APPENDIX 1: INFLUENT IMAGE ANALYSIS DATA X10 MAGNIFICATION 

 

Column1 Column2 Column3 Column4 Column5 Column6 Column7 Column8 Column9 Column10 Column11 Column12 Column13 Column14

No Slice Count Total Area Average Size %Area Perim. Major Minor Angle Feret FeretX FeretY FeretAngle MinFeret

1 2-10_15-45-31 76 21012.235 276.477 8.433 51.914 7.753 4.906 56.916 17.188 358.293 211.148 114.885 10.735

2 2-10_15-45-38 98 11617.986 118.551 4.663 44.826 8.821 4.966 64.986 15.897 297.026 217.559 110.395 9.406

3 2-10_15-45-45 203 19776.65 97.422 7.937 34.519 7.891 4.364 58.051 11.898 321.429 225.598 110.648 6.863

4 2-10_15-45-52 43 5725.195 133.144 2.298 63.925 6.501 3.815 46.654 21.907 425.591 170.234 120.058 12.971

5 2-10_15-45-59 140 17144.853 122.463 6.881 42.235 8.929 5.201 53.059 14.433 347.211 168.799 106.979 8.636

6 2-10_15-46-6 156 18064.572 115.799 7.25 39.384 8.541 5.049 49.435 13.491 332.606 158.374 107.851 8.082

7 2-10_15-46-13 234 28076.297 119.984 11.269 31.089 6.897 4.076 58.761 10.326 304.18 216.318 110.304 6.117

8 2-10_15-46-20 224 28415.608 126.855 11.405 31.772 7.121 4.229 68.725 10.586 300.04 218.628 112.03 6.288

9 2-10_15-46-27 96 22835.832 237.873 9.165 38.866 6.87 4.563 48.413 13.451 285.132 116.472 115.902 8.341

10 2-10_15-46-34 93 25059.569 269.458 10.058 42.966 8.174 4.917 57.763 14.896 278.648 180.976 115.755 8.91

11 2-10_15-46-41 120 22498.422 187.487 9.03 34.218 6.66 4.221 50.075 12.052 336.696 162.222 110.513 7.349

12 2-10_15-46-48 172 20227.48 117.602 8.118 35.14 7.529 4.553 55.109 12.001 321.687 185.965 109.313 7.251

13 2-10_15-46-55 171 20293.378 118.675 8.145 35.688 7.621 4.634 62.643 12.153 319.931 190.874 113.48 7.333

14 2-10_15-47-2 210 16148.148 76.896 6.481 28.895 6.281 3.555 66.225 10.002 312.564 175.89 114.604 5.732

15 2-10_15-47-9 239 17307.064 72.414 6.946 27.299 6.033 3.242 57.028 9.418 289.489 183.859 109.54 5.245

16 2-10_15-47-16 259 23712.464 91.554 9.517 23.067 4.971 2.959 52.742 7.77 344.686 152.502 108.812 4.581

17 2-10_15-47-23 209 16515.022 79.019 6.628 30.718 6.614 3.837 57.19 10.429 288.968 163.406 109.818 6.181

18 2-10_15-47-30 222 16500.131 74.325 6.622 29.428 6.348 3.751 61.783 10.058 290.976 179.473 113.994 5.967

19 2-10_15-47-37 156 12127.744 77.742 4.868 31.331 5.823 3.534 57.313 10.57 283.46 163.029 114.547 6.4

20 2-10_15-47-44 139 14394.25 103.556 5.777 35.258 6.568 3.72 56.115 11.977 329.754 163.62 111.924 6.909

21 2-10_15-47-51 146 15556.651 106.552 6.244 36.39 7.223 3.92 58.179 12.528 324.734 129.864 113.751 7.081

22 2-10_15-47-58 90 15505.96 172.288 6.223 47.121 7.949 4.479 66.293 15.542 266.135 264.365 107.326 9.141

23 2-10_15-48-5 73 13320.242 182.469 5.346 50.967 8.136 4.52 50.195 17.216 259.951 229.965 108.2 10.115

24 2-10_15-48-12 115 13815.11 120.131 5.545 32.599 5.987 3.617 59.817 11.628 277.864 125.72 115.578 7.006

25 2-10_15-48-19 66 15744.207 238.549 6.319 66.237 10.365 5.533 55.302 21.007 378.663 138.746 108.567 12.17

26 2-10_15-48-26 71 15655.498 220.5 6.283 60.31 9.97 5.214 65.336 19.789 391.239 141.192 113.376 11.426

27 2-10_15-48-33 105 12346.664 117.587 4.955 37.854 7.14 3.919 53.88 13.472 276.168 150.119 116.363 7.822

28 2-10_15-48-40 109 13507.481 123.922 5.421 40.676 8.156 4.211 71.749 14.341 263.348 153.579 114.519 8.117

29 2-10_15-48-47 115 9088.521 79.031 3.648 39.334 7.136 4.315 64.579 13.782 304.539 196.68 104.158 8.214

30 2-10_15-48-54 28 5191.675 185.417 2.084 84.349 6.788 4.47 55.224 29.899 200.842 92.511 119.606 18.176

31 2-10_15-49-1 74 9979.093 134.853 4.005 55.307 9.567 4.954 54.167 19.183 318.368 165.596 107.193 10.835

32 2-10_15-49-8 174 12684.391 72.899 5.091 32.46 7.091 3.783 64.604 11.468 353.938 146.374 109.982 6.536

33 2-10_15-49-15 288 17464.838 60.642 7.01 23.941 5.621 3.148 57.103 8.46 342.456 185.161 112.325 4.913

34 2-10_15-49-22 288 17638.454 61.245 7.079 24.255 5.618 3.119 58.354 8.445 332.952 180.953 108.851 4.884

35 2-10_15-49-29 155 40122.936 258.858 16.104 36.549 7.013 4.169 62.233 11.728 264.136 172.189 117.669 7.063

SAMPLE A TRIAL 1 X10 MAGNIFICATION
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36 2-10_15-49-36 89 37643.846 422.965 15.109 51.396 8.531 5.564 53.954 16.346 256.559 171.225 110.933 10.234

37 2-10_15-49-43 136 15122.612 111.196 6.07 28.395 5.904 3.145 45.143 10.405 229.769 160.247 111.933 6.03

38 2-10_15-49-50 129 18708.027 145.023 7.509 41.565 7.595 4.32 51.696 13.426 331.287 176.321 113.827 7.849

39 2-10_15-49-57 211 21615.771 102.444 8.676 30.276 6.513 3.599 61.792 10.181 369.053 127.506 109.672 5.884

40 2-10_15-50-4 193 27205.685 140.962 10.919 28.969 5.973 3.767 50.047 9.669 368.548 160.177 116.276 5.861

41 2-10_15-50-11 295 25291.162 85.733 10.151 23.366 5.129 2.984 52.349 7.756 359.056 169.75 117.158 4.582

42 2-10_15-50-18 195 12396.405 63.571 4.975 25.675 4.862 3.061 54.042 8.745 366.872 166.752 114.585 5.393

43 2-10_15-50-25 103 18735.906 181.902 7.52 34.527 6.197 3.893 57.714 12.16 303.592 186.734 110.979 7.352

44 2-10_15-50-32 91 18897.166 207.661 7.585 40.005 7.026 4.263 63.58 13.844 321.594 174.228 112.759 8.202

45 2-10_15-50-40 90 18821.131 209.124 7.554 39.825 6.894 4.282 49.505 13.755 298.087 187.44 114.337 8.241

46 2-10_15-50-47 111 18884.811 170.133 7.58 32.329 5.887 3.662 52.962 11.47 296.209 193.884 112.848 6.878

47 2-10_15-50-53 89 18869.92 212.022 7.574 40.242 6.993 4.354 54.373 13.927 303.435 164.641 115.28 8.352

48 2-10_15-51-1 179 12078.954 67.48 4.848 26.597 4.994 2.948 54.184 9.015 287.313 128.242 113.008 5.394

49 2-10_15-51-8 122 10785.391 88.405 4.329 32.046 5.849 3.292 59.503 11.331 320.224 146.22 114.257 6.69

50 2-10_15-51-15 95 9724.689 102.365 3.903 39.42 6.423 4.048 63.35 13.904 355.108 105.475 111.59 8.473

51 2-10_15-51-21 58 6343.304 109.367 2.546 58.905 8.375 5.412 72.929 20.595 357.225 153.837 98.123 12.537

52 2-10_15-51-29 114 11059.121 97.01 4.439 38.915 7.265 4.217 64.071 13.545 293.504 193.384 116.547 8.011

53 2-10_15-51-36 244 21349.011 87.496 8.569 31.308 7.05 3.875 58.186 10.59 341.804 192.283 106.121 6.118

54 2-10_15-51-43 199 22850.089 114.825 9.171 31.932 6.407 3.846 57.292 10.22 282.668 181.138 114.019 6.255

55 2-10_15-51-50 190 24088.525 126.782 9.668 31.548 6.416 3.836 57.145 10.244 338.569 169.864 119.618 6.16

56 2-10_15-51-57 303 31175.399 102.889 12.512 22.032 5.01 3.037 49.22 7.373 322.261 137.025 118.811 4.381

57 2-10_15-52-4 296 41754.542 141.063 16.758 24.877 5.914 3.487 57.488 8.424 318.798 150.774 113.879 4.922

58 2-10_15-52-11 301 41624.33 138.287 16.706 23.771 5.677 3.352 54.769 8.078 322.501 150.059 115.925 4.754

59 2-10_15-52-18 302 37548.167 124.332 15.07 24.363 5.518 3.258 50.539 7.912 345.649 159.693 114.217 4.762

60 2-10_15-52-25 311 38056.024 122.367 15.274 24.087 5.319 3.213 49.084 7.684 354.189 162.29 112.594 4.724

61 2-10_15-52-32 266 40576.935 152.545 16.286 23.536 5.696 3.339 50.862 8.089 293.485 160.014 113.372 4.844

62 2-10_15-52-39 192 26304.975 137.005 10.558 32.083 6.824 3.917 52.276 10.626 343.016 157.344 108.175 6.327

63 2-10_15-52-46 99 11521.99 116.384 4.624 40.622 6.576 3.915 58.152 13.594 326.683 243.175 113.241 8.239

64 2-10_15-52-53 132 11457.993 86.803 4.599 32.859 6.134 3.063 61.912 11.512 275.757 183.17 121.626 6.426

65 2-10_15-53-0 132 19374.292 146.775 7.776 33.106 6.633 3.329 56.483 11.744 315.149 132.214 119.363 6.417

66 2-10_15-53-7 98 18596.825 189.764 7.464 37.553 6.207 4.033 55.929 12.967 282.363 153.306 113.832 7.727

67 2-10_15-53-14 63 4887.531 77.58 1.962 48.087 5.976 3.755 62.835 17.08 287.052 124.465 115.705 10.235

68 2-10_15-53-21 150 19462.051 129.747 7.811 27.853 5.691 3.168 48.845 9.771 379.461 162.597 114.813 5.806

69 2-10_15-53-28 239 16540.05 69.205 6.638 25.646 5.611 3.144 57.561 8.801 326.942 140.16 112.252 5.205

70 2-10_15-53-35 153 27746.491 181.35 11.136 40.137 8.977 5.301 65.245 13.63 324.755 177.751 108.55 8.263

71 2-10_15-53-42 227 29576.741 130.294 11.871 29.935 6.524 3.893 53.232 9.845 302.216 140.124 111.016 5.932

72 2-10_15-53-49 127 12339.061 97.158 4.952 34.271 6.032 3.491 47.818 11.588 414.038 102.375 120.544 6.817

73 2-10_15-53-56 99 9260.869 93.544 3.717 43.356 7.309 4.155 57.935 14.816 347.219 117.838 111.166 8.683

74 2-10_15-54-3 94 11656.321 124.003 4.678 44.578 8.395 4.821 72.931 15.953 316.114 187.602 122.719 9.331

75 2-10_15-54-10 31 3910.786 126.154 1.57 84.416 8.542 4.961 60.625 30.459 343.311 96.667 104.799 17.687

76 2-10_15-54-17 78 6924.346 88.774 2.779 47.554 7.896 4.56 64.017 17.053 282.132 148.726 108.68 10.006

77 2-10_15-54-24 60 3985.554 66.426 1.6 50.589 6.405 3.978 64.454 18.101 354.314 101.1 100.145 10.97
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APPENDIX 2:  EFFLUENT IMAGE ANALYSIS DATA X10 MAGNIFICATION 

 

Column1 Column2 Column3 Column4 Column5 Column6 Column7 Column8 Column9 Column10 Column11 Column12 Column13 Column14

No Slice Count Total Area Average Size %Area Perim. Major Minor Angle Feret FeretX FeretY FeretAngle MinFeret

1 2-10_14-48-16 33 2476.239 75.038 0.994 128.734 4.826 3.011 68.047 25.626 388.036 85.436 106.074 15.057

2 2-10_14-48-23 41 2496.833 60.898 1.002 104.911 4.281 2.659 74.916 21.093 348.468 91.253 108.147 12.425

3 2-10_14-48-30 64 2609.302 40.77 1.047 68.857 3.286 2.117 53.346 14.178 410.003 114.948 110.116 8.356

4 2-10_14-48-38 52 2555.444 49.143 1.026 84.439 4.045 2.43 56.908 17.354 381.124 97.213 109.974 10.146

5 2-10_14-48-45 40 2484.16 62.104 0.997 107.564 4.318 2.695 77.07 21.583 392.345 107.803 106.978 12.726

6 2-10_14-48-52 51 2532.316 49.653 1.016 85.765 3.866 2.335 63.478 17.469 371.645 114.824 110.28 10.217

7 2-10_14-48-58 56 2531.366 45.203 1.016 78.278 3.732 2.301 52.733 16.118 347.117 124.262 103.827 9.457

8 2-10_14-49-6 41 2543.405 62.034 1.021 106.043 4.35 2.732 59.321 21.328 359.478 77.662 106.24 12.57

9 2-10_14-49-13 54 2568.433 47.564 1.031 81.902 3.951 2.346 68.837 16.864 389.826 94.53 109.267 9.827

10 2-10_14-49-20 28 2441.073 87.181 0.98 151.278 5.312 3.257 66.788 29.817 399.513 59.603 102.342 17.497

11 2-10_14-49-27 55 2614.055 47.528 1.049 80.749 4.03 2.405 64.186 16.669 279.447 120.637 117.564 9.765

12 2-10_14-49-34 48 2600.748 54.182 1.044 91.963 4.448 2.693 72.118 18.91 407.291 71.953 117.318 11.12

13 2-10_14-49-41 56 2813.649 50.244 1.129 80.902 4.515 2.729 58.36 16.99 301.746 88.39 109.269 9.979

14 2-10_14-49-48 62 2677.735 43.189 1.075 72.794 3.861 2.407 64.798 15.13 365.599 125.201 101.391 8.968

15 2-10_14-49-55 36 2535.801 70.439 1.018 119.45 4.638 2.855 58.934 23.813 304.088 93.529 113.308 13.942

16 2-10_14-50-2 60 2590.293 43.172 1.04 73.985 3.685 2.294 57.776 15.314 393.527 92.601 108.97 8.987

17 2-10_14-50-9 60 2564.315 42.739 1.029 73.598 3.554 2.258 48.478 15.165 246.872 132.011 114.619 8.951

18 2-10_14-50-16 74 2845.648 38.455 1.142 62.142 3.469 2.131 56.084 12.991 313.348 155.138 114.604 7.606

19 2-10_14-50-23 62 2797.808 45.126 1.123 72.629 3.584 2.326 55.781 14.839 321.65 102.723 112.439 8.778

20 2-10_14-50-30 48 2475.606 51.575 0.994 89.736 3.567 2.307 52.936 17.992 285.701 111.623 119.858 10.589

21 2-10_14-50-37 61 2554.493 41.877 1.025 72.604 3.51 2.217 54.682 14.972 297.802 146.391 113.736 8.826

22 2-10_14-50-44 80 2640.034 33 1.06 56.951 3.407 2.044 64.129 12.167 356.3 133.758 115.716 7.141

23 2-10_14-50-51 56 2494.298 44.541 1.001 77.65 3.464 2.12 55.616 15.805 296.248 105.547 113.018 9.239

24 2-10_14-50-58 60 3137.436 52.291 1.259 76.983 4.131 2.423 46.419 15.843 263.346 139.459 108.056 9.258

25 2-10_14-51-5 59 2582.373 43.769 1.036 75.026 3.702 2.222 59.684 15.483 374.82 93.188 114.477 9.047

26 2-10_14-51-12 51 2562.414 50.243 1.028 86.061 3.83 2.407 61.456 17.444 262.096 88.789 110.879 10.3

27 2-10_14-51-19 72 2764.226 38.392 1.109 64.025 3.897 2.347 66.721 13.665 318.855 113.495 112.568 8.033

28 2-10_14-51-26 60 2554.81 42.58 1.025 73.335 3.482 2.052 52.979 15.053 260.71 117.779 112.92 8.753

29 2-10_14-51-33 75 2761.691 36.823 1.108 61.655 3.833 2.263 65.928 13.212 350.702 117.819 112.472 7.701

30 2-10_14-51-40 58 2551.959 43.999 1.024 75.52 3.476 2.188 59.43 15.449 284.538 138.135 114.537 9.082

31 2-10_14-51-47 73 2702.447 37.02 1.085 62.482 3.61 2.217 59.353 13.241 338.282 144.726 102.809 7.843

32 2-10_14-51-54 89 2775.948 31.19 1.114 52.483 3.425 2.158 60.099 11.37 367.614 124.905 107.904 6.787

33 2-10_14-52-1 67 2588.076 38.628 1.039 66.833 3.55 2.139 58.036 13.988 318.237 136.49 112.001 8.201

34 2-10_14-52-8 161 4370.487 27.146 1.754 36.938 4.202 2.056 59.335 9.051 403.301 204.491 100.891 4.885

35 2-10_14-52-15 38 2453.745 64.572 0.985 115.971 4.729 2.684 61.584 22.896 361.181 92.813 106.651 13.252

SAMPLE B TRIAL 3 x10 MAGNIFICATION
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36 2-10_14-52-22 24 2347.295 97.804 0.942 179.835 5.684 3.45 74.294 34.337 396.562 42.426 111.312 20.116

37 2-10_14-52-29 23 2346.028 102.001 0.942 185.722 5.597 3.455 62.71 35.392 417.792 19.921 113.399 20.734

38 2-10_14-52-36 27 2401.787 88.955 0.964 161.005 5.622 3.412 72.363 31.131 437.742 29.165 110.024 18.231

39 2-10_14-52-43 24 2340.008 97.5 0.939 178.596 5.488 3.341 65.028 34.038 402.261 18.692 107.601 19.922

40 2-10_14-52-50 21 2336.523 111.263 0.938 203.677 6.028 3.742 69.193 38.665 443.269 2.385 110.464 22.655

41 2-10_14-52-57 26 2530.732 97.336 1.016 168.886 6.076 3.845 75.389 32.567 403.271 28.793 106.587 19.223

42 2-10_14-53-4 28 2994.235 106.937 1.202 163.097 7.074 4.291 71.27 31.968 414.691 54.256 107.334 18.872

43 2-10_14-53-11 21 2323.534 110.644 0.933 203.657 6.074 3.633 69.656 38.623 443.35 2.385 108.786 22.547

44 2-10_14-53-18 22 2320.999 105.5 0.932 194.975 5.795 3.551 66.232 36.914 432.715 12.076 110.527 21.599

45 2-10_14-53-25 25 2333.989 93.36 0.937 172.252 5.276 3.268 65.056 32.714 417.961 19.858 116.055 19.165

46 2-10_14-53-32 23 2697.694 117.291 1.083 194.42 7.072 4.019 70.789 37.226 409.668 30.028 108.25 21.828

47 2-10_14-53-39 27 2593.145 96.042 1.041 164.03 6.1 3.433 63.019 31.788 427.444 70.421 100.672 18.569

48 2-10_14-53-46 23 2344.761 101.946 0.941 185.529 5.56 3.468 63.131 35.344 413.608 18.721 111.591 20.734

49 2-10_14-53-53 21 2340.008 111.429 0.939 203.885 6.029 3.724 69.483 38.655 443.269 2.385 110.201 22.655

50 2-10_14-54-0 34 2512.357 73.893 1.008 129.737 5.22 3.259 71.097 25.597 333.017 60.061 110.075 15.056

51 2-10_14-54-7 21 2342.226 111.535 0.94 202.639 6.019 3.727 68.44 38.644 443.35 2.627 107.343 22.655

52 2-10_14-54-14 21 2337.157 111.293 0.938 203.189 6.06 3.688 69.059 38.611 443.43 2.385 108.21 22.601

53 2-10_14-54-21 24 2328.286 97.012 0.934 178.598 5.448 3.316 70.796 33.973 396.022 22.468 111.996 19.87

54 2-10_14-54-28 31 2355.532 75.985 0.945 139.93 4.637 2.885 57.85 26.852 428.74 58.011 111.106 15.763

55 2-10_14-54-35 26 2333.989 89.769 0.937 165.756 5.134 3.211 61.888 31.52 366.706 24.03 110.731 18.513

56 2-10_14-54-42 55 2550.691 46.376 1.024 80.381 3.943 2.32 62.046 16.618 334.311 92.3 113.055 9.703

57 2-10_14-54-49 71 3359.524 47.317 1.348 67.053 4.413 2.481 76.728 14.45 334.413 120.897 113.902 8.351

58 2-10_14-54-56 91 2719.871 29.889 1.092 51.241 3.353 2.007 56.639 11.138 342.265 118.115 103.889 6.506

59 2-10_14-55-2 105 5637.437 53.69 2.263 49.68 4.533 2.719 64.062 11.45 359.767 112.53 104.736 6.76

60 2-10_14-55-9 53 5800.281 109.439 2.328 91.709 5.953 3.308 55.29 19.297 342.201 95.581 106.261 11.07

61 2-10_14-55-16 64 2527.564 39.493 1.014 69.476 3.408 2.008 61.652 14.268 382.519 120.383 112.357 8.297

62 2-10_14-55-23 52 2614.371 50.276 1.049 86.505 4.119 2.525 63.502 17.628 273.249 164.227 111.008 10.381

63 2-10_14-55-30 58 2580.155 44.485 1.036 76.591 3.729 2.315 61.469 15.715 363.125 84.391 112.846 9.261

64 2-10_14-55-37 52 3063.618 58.916 1.23 87.397 4.596 2.737 68.667 18.03 308.125 90.481 113.911 10.546

65 2-10_14-55-44 43 2581.106 60.026 1.036 102.78 4.63 2.547 73.098 20.75 366.935 75.162 108.608 11.873

66 2-10_14-55-51 37 2505.703 67.722 1.006 116.772 4.422 2.812 51.39 23.04 347.151 85.419 115.374 13.568

67 2-10_14-55-58 28 2411.292 86.118 0.968 152.105 5.214 3.222 70.604 29.717 350.303 66.579 106.02 17.433

68 2-10_14-56-5 36 3142.505 87.292 1.261 124.377 5.459 3.687 65.166 24.829 404.794 65.511 109.009 14.942

69 2-10_15-1-52 184 12126.477 65.905 4.867 47.687 8.306 4.622 76.858 12.924 285.002 167.449 101.161 7.472

70 2-10_15-1-59 188 12230.393 65.055 4.909 46.525 8.149 4.585 81.545 12.664 285.741 166.707 103.541 7.338

71 2-10_15-2-6 202 11787.483 58.354 4.731 43.691 8.003 4.521 80.806 12.24 348.965 167.77 101.637 7.11

72 2-10_15-2-13 187 11993.097 64.134 4.814 46.464 8.008 4.498 79.159 12.466 282.423 170.226 99.388 7.208


